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Course goals 

 Learn about editing existing data 

 Use functions available in Excel 

 Create a simple chart 

 Learn how to use Filter 
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Office Environment in Excel 
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Formulas 

Data 

Review 

View 
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Excel 2010 Information 

 Available Columns: 

 A through XFD – 16,384 columns 

 Available Rows:  

 1 through 1,048,576 

 There are over 17 billion cells in each worksheet!!!! 

 A cell is the intersection of a column letter and a row 

number. The cell address can be found in the Name Box 

just above column A. 
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Excel 101 Review 
1. When entering data, don’t create empty cells – it’s OK if data 

from one cell “spills over” into another cell. Adjustments can 
be made to column width to compensate for that. 

2. Pay attention to what is actually in the cell – it could look like 
a number that was typed, but could be a formula  

3. Remember how the mouse pointer changes to accomplish 
different tasks 

4. The Name Box just above column A shows you what cell is 
active and there should be a dark border around the active 
cell. If you have multiple cells selected, the first cell shows in 
the cell reference area and that cell is white, while the others 
are shaded to show that they are selected. 

5. All formulas begin with the equals sign (=) 
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Working with the Quick Access Toolbar 

You were introduced to the Quick Access toolbar in Excel 101. 
You can easily add some useful tools to the toolbar. To 
add/remove an item, click the down arrow to the right of the 
toolbar and click an item to add it. If it has a checkmark, it’s 
already displayed and clicking it will remove it. 

 New workbook 

 Quick Print 

 Open 

Reordering the tools on Quick Access toolbar– icons are 
shown in the order added. You could remove each tool, then re-
add to change the order, or click the down arrow to the right of 
the toolbar and choose More Commands…  

The selected Quick Access Toolbar icons are on the right-hand 
side. Click one and choose to move it up or down. Click OK. 
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Mouse Pointers in Excel 
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1. Select – main mouse pointer used for selecting cells. Click once in a 
cell to select it or click and drag to select several cells. 

2. Fill - appears after you have selected a cell (or cells) and will show 
only at the bottom right of the selection (tiny box called the Fill 
Handle). Using this will allow you to fill a series such as Monday, 
Tuesday, Wednesday, etc. 

3. Insertion point - appears when you are typing or have double-
clicked in a cell. The flashing insertion point determines where new 
text and numbers appear. 

4. Column/Row selector - appears when you are over a column or 
row, allowing you to click once to select the entire column or row 

5. Resize - appears when you are between columns or rows, allowing 
you to resize them 



Working with Worksheets 
 Each Excel file is a Workbook containing one or more Worksheets 

 Default setting provides you with three worksheets – you can add or 
remove as needed from there: 

 To add a worksheet, right-click a tab and choose Insert, then click OK to add a 
Worksheet (note – they begin adding as sheet4, sheet5, etc. – sheets can be 
renamed  as needed), or click the Insert Worksheet tab after the last sheet 

 To remove a worksheet, right-click the tab of the sheet to be removed, then 
choose Delete 

 To move a worksheet, click on the sheet tab and drag it to the new position 

 To rename a worksheet, right-click on the sheet tab and choose Rename – 
the new name can be 31 characters long and can contain spaces 

 To change the color of the sheet tab, right-click on the sheet tab, choose 
Tab Color and pick a color (to see the full effect of the color click another 
tab) 
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If you want to control how many sheets are in each new workbook, go to File/Options/General – in the 
“When creating new workbooks” section, you can adjust how many sheets are in each new workbook 

(note – this does not affect any workbooks you’ve already created). 



Navigating multiple worksheets 

 Once you have several worksheets in the workbook, 

some sheets may be scrolled off the screen to the right 

or left 

 There are navigation buttons to the left of the sheet tabs (just 

below the row numbers. You can click those buttons right or left 

until the sheet you need comes into view. 

 

 Another option is to right-click on the navigation buttons and 

pick the sheet from the list of sheets in the workbook 
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Basic Editing 
 Click a cell to type into it. After typing, press Enter to move down one cell or 

press right arrow key (or tab) to move to the right one cell. 

 To delete the contents of a cell, select the cell, then press Delete on the 
keyboard (never press Spacebar to remove something from a cell – it leaves a 
character in the cell) 

 To replace something in a cell (or cells), select the cell (or cells), then begin 
typing the replacement. Or, you can press Delete on the keyboard before typing 
the replacement. 

 Undo/Repeat the replacement (this works even after the workbook has been 
saved) 

 Select a cell and choose Cut (to move data) from the Ribbon or choose Copy 
(to make a copy of the data) 

 Click in a new cell and choose Paste from the Ribbon to paste the cut or copied 
data 
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Remember – there is always more than one way to accomplish a 

task (usually two or three ways) so find what works for you. 



Editing Existing Data 

To edit data that is already in the worksheet: 

 Click once on the cell to make it active. Then click in 

the Formula Bar where you would like to add/remove 

information (remember, the insertion point needs to 

be in the correct location) and make the change(s), 

then press Enter to accept the change(s). 

Or you can double-click in the cell to get into Edit mode, then click 

in the data where you would like to add/remove information 

(remember, the insertion point needs to be in the correct location) 

and make the change(s), then press Enter to accept the change(s). 

Note – you can also press F2 to enter Edit mode if you prefer to use 

the keyboard 
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Using AutoFill to work faster 

AutoFill can help you fill in days of the week or months of 

the year. Did you know you can also create your own lists?  
 

 Excel recognizes serial data, so if you type Q1 into a cell 

and AutoFill from there, it will automatically put Q2 into 

the 2nd cell and continue on that way. And, Excel knows 

that quarters end at 4, so when it reaches Q4, it will 

begin again with Q1. 

 You can also copy formulas using AutoFill – cell 

references will adjust as you copy 
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To teach Excel what you want it to do, type the first two in 
the series (one per cell), select both cells, then AutoFill 



Formulas 
Excel can handle calculations – from very simple summing (adding) to 
very complicated multi-formula calculations 

 Excel uses Formulas to perform calculations 

 All formulas begin with = (the equals sign, next to Backspace 
key on the keyboard) 

 Add - + 

 Subtract - - 

 Multiply - * 

 Divide - / 

 A Circular Reference is created when you include the cell that 
contains the result in your formula – if you begin a formula in cell 
B8, then include B8 in the formula, you will get a message about a 
circular reference and the formula will not calculate correctly. 
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Order of Precedence 

Percent 

Exponentiation 

Multiplication/Division 

Addition/Subtraction 



Errors when creating formulas 
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Copied from http://www.dummies.com/how-to/content/deciphering-error-values-in-excel-
2010-formulas.navId-405658.html 

 

To find out more about an error, click the cell with the green triangle 
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Functions 
 Functions can help you perform complicated calculations easily. To 

access Functions, click the Insert Function (fx) button on the formula 
bar 

 

 Functions and formulas can also be accessed on the Formulas tab in 
the Ribbon 

 

 You’ll need to have some understanding of functions in order to use 
them, so refer to 
http://www.dummies.com/how-to/content/commonly-used-excel-
functions.navId-405656.html  
    OR 
http://www.excelfunctions.net/ExcelFunctions.html  
note: this site provides links to explain and show examples for each 
function. 
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Filtering 
 Filtering can help you by showing you only the data you 

need to see at the moment. The other data is still there, but 
hidden when you filter. 

 To filter, click on any cell within the data (note – Excel sees an 
empty row or column as the end of the data).  
Click the Data tab on the Ribbon and click the Filter button. 

 Once the filter is set on, you will see down arrows at the top 
of each column. If you have column headings (highly 
recommended), those will be the cells with the down arrows 

 To filter the data, click the down arrow in the column, make 
your choices and click OK. Note – to de-select everything 
turn off the checkbox in Select All by clicking the box, then 
select individual values 

 

4/19/2011 Microsoft Excel 102 17 



Filtering continued 
 When you have data filtered there are visual cues on the 

screen.  
You should see blue row numbers and there should be a filter 
picture (looks like a funnel) on the column that is filtered. 
When you hover over a down arrow you will see Showing All. 
When you hover over the funnel, you will see the data filter 
that was applied. 
The status bar shows how many records are displayed with 
the filter applied. 

 To return to Showing All of the data on a filter, click the 
filtered column heading (the funnel), choose Select All, then 
click OK 

 Turn off Filter the same way you turned it on. Go to Data, 
then click Filter 
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Creating Charts 

 Charts are pictures of worksheet data. Pictures are much 
easier for others to get a better understanding of the 
numbers in a spreadsheet. 

 To create a chart in Excel, first choose the data you 
would like to include in the chart (click once to select a 
single cell in the data or click and drag to select several 
cells if you want the chart to display data from certain 
cells). Then, go to the Insert tab – in the Chart group 
choose the type of chart to represent your data. The 
chart will become part of your worksheet. 
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For help in choosing chart types, go to http://www.dummies.com/how-
to/content/how-to-choose-the-right-chart-type-in-excel-2010.html . 
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Working with charts 

Once inserted, you can make changes to a chart, 
including changing it’s type. 

Note the new tabs that appear when the chart is 
selected: Design, Layout & Format. These allow you 
to work with the chart to customize it. 

One of the changes you can make is to the grouping 
of your data to see it represented in a different way – 
this can highlight data that might not have been 
obvious before.  
Be sure the chart is selected – on the Design tab, 
click Switch Row/Column. 
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Printing 

1. Go to File/Print 

2. Print Preview shows how your worksheet will appear 

printed (you can zoom in or out and move to other 

pages in your worksheet). 

If you decide to make formatting changes, you’ll need to go back to 

the workbook – click File a 2nd time or click Home to get back to the 

workbook. 

3. Be sure to click the Print button on the left side to send 

the worksheet to the printer. 

4/19/2011 Microsoft Excel 102 21 



Getting Help in Office 

 In any Office 2010 program, go 

to File/Help/Getting Started. 

This brings you to the Office 

website for that program 

where you can: 

 See what’s new in a program 

 Make the switch from a previous 

version 

 Find menu items in the ribbon 

and learn basic tasks 

Microsoft Excel 102 

Excel 2010 Getting Started web page: 
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Commonly used tasks in Excel 2010 

– New 

• Click File/New 

• Choose type of workbook (default is blank) then click Create 

– Save 

• Click the Save button in the Quick Access Toolbar (above the ribbon) – 
we recommend using this button often – you can’t wear it out! 

– Save As (save a duplicate of the file with a new name) 

• Click File/Save As 

• Name the file, then click Save (you are now working with the new 
version of the file – the original has closed and will stay as you left it) 

– Open 

• Click File/Open 

• Choose a file, then click Open 
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Commonly used tasks in Excel 2010 

– Close 

• Click File/Close to close the current workbook and continue 
working in Excel. If you want to exit Excel, you can click the x in 
the top right corner. 

– Recent Files List 

• Click File/Recent 
You’ll see a list of your recent files, newest at the top, as well as 
folders you have recently opened 

• To quickly access the most recent files, click the checkbox next to 
Quickly access this number of files and set the number of files 
(default is 4). They will appear just above Info. 

– Print Preview 

• Click File/Print (the preview appears on the right side of the 
screen) 
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Commonly used tasks in Excel 2010 

– Print 

• Click File/Print. 

• Choose print settings as needed – to choose properties of the 
selected printer, click Printer Properties 

– Format Painter (Word, Excel, PowerPoint) 

• Select the formatted text to copy, click Home/Format Painter.  

• Click where you would like to apply that formatting 

– Page Setup 

• Click Page Layout tab, then Page Setup group. If you would like 
to see all options for Page Setup, click the Dialog Box Launcher 
(arrow to the right in the Page Setup group) 
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Commonly used tasks in Excel 2010 

– Undo  

• To undo the last task, click the Undo button in the Quick 

Access Toolbar (above the ribbon) – click multiple times to 

undo multiple tasks 

– Options 

• Click File/Options – categories are on the left. When making 

changes to options, make changes slowly so you can test and 

be sure Excel is working the way you’d like it to work. You can 

undo options by unchecking each one, but there is no reset 

to return to the default options. 
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Customizing Office Programs 

• Customizing the Quick Access Toolbar 

• Click the down arrow near the Undo button (top left of 

screen) 

 
 

• Choose from the common tasks shown. If there is no 

checkmark next to an option, click to turn on. If checked, click 

to turn the option off. 

Note: Click More commands…to open a window to choose 

any command to add to the Quick Access Toolbar 
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Resources 

Books 

 Microsoft Office Excel 2010 QuickSteps by John Cronan 

 Excel 2010 Simplified by Paul McFedries 

 Teach Yourself Visually Excel 2010 by Paul McFedries 

 Excel 2010 Workbook for Dummies by Greg Harvey 

 Microsoft Office 2010 All-In-One For Dummies by Peter Weverka 

 Office 2010 For Dummies by Wallace Wang 

 Discovering Microsoft Office 2010 : Word, Excel, Access, PowerPoint 
by Edward G. Martin 
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All books on this list are available in the Mid-Hudson Library system 
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 Resources - Websites 
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We can send you a document in PDF format with clickable links – 
please provide your email address on the evaluation to receive the 
document. 
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Contact Information 

To contact PPLD Technology Trainers in BTOP 

(Broadband Technology Opportunities Program): 

Email – BTOP@poklib.org 

Debbie Minnerly – dminnerly@poklib.org 

Phone – 845-485-3445  

Debbie Minnerly - x3380 
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